
 

LIDS - Learning Important Digital Skills for people with needs in digital literacy 

Curriculum 
 

Preliminary remarks 

● The curriculum presented here was created by representatives from nine European countries after an intensive 

survey among teachers of adult education. It shows the most important learning goals that should be 

implemented in adult education for beginners. 

● Emphasis is placed on the implementation in exercises and in practice. 

● A * means that this learning goal may be too difficult for beginners. But it is necessary for a basic understanding. 

● No time constraints have been set, because each teacher must choose their own pace according to their 

progress. 

This curriculum has 4 main learning objectives (left column) 

● Objective A: Essential Skills for ICT Hardware (How to use the most important hardware?) 

● Objective B: Essential Software Skills (How to use the most important software?) 

● Objective C: Using ICT in Daily Life 

● Objective D: The concept of privacy and why privacy matters online 

Learning 
Objective 

 

Subordinate 
Learning 
Objective 

Learning Content in the Order, which you should teach 
Everything must be learned through practical exercises! 

Objective A: 
Essential Skills 
for ICT 
Hardware (How 
to use the 
hardware?) 
 
 
 

Basic Computer 
Skills (hardware 
and operating 
system) 
 

Switch on the whole System 
1. What are the components of the computer system, which I must switch 

on? 

2. What do I have to look out for? 

3. Where is the switch? 

4. How can I identify and correct simple faults? 

5. How do I know that the system is running, and everything is fine? 

6. Eliminate simple malfunction 

7. Checking power supply 



Learning 
Objective 

 

Subordinate 
Learning 
Objective 

Learning Content in the Order, which you should teach 
Everything must be learned through practical exercises! 

Components of 
computer system 
(Hardware) 

Overview of the components of a computer hardware  
1. name 

2. function 

Explanation of the individual components 
1. What are they for? 

2. When do I need it? 

Examples of typical hardware  
1. central processing unit 

2. input devices 

3. output devices 

Here you must explain the following:  
1. monitor 

2. keyboard 

3. mouse 

4. computer memory 

5. use of external memory CD, DVD, USB-stick 

6. printer 

What is data and information in a computer technology sense? 
 

Components of 
computer system 
(Software) 
 

Learn to know examples of typical software: 
1. Operating system OS 

a. Name of the OS 

b. OS simple settings  

c. Changing system date and time 

2. Name of the writing program 

a. Start the writing program 

b. Write some words 

c. Print, what you have written 

d. Save the file 

e. Adding and removing printers in the OS 

3. Start an easy painting program 

a. Paint a simple picture 

b. Print the picture 

c. Save the picture 

d. Keyboard and mouse exercises 

4. File finding System * 

a. Finding files 

b. Creating files  

c. Renaming of files 

Essential first 
skills for Mobile 
Phones and 
Tablets 

1. Differences and similarities to the computer 

2. Get to know different devices 

a. Detect foreign devices 

b. Can turn on and off 

c. Can use battery and charger 

3. Experience touchscreen 

a. Input and output device 

b. Operation with fingers 

c. Simple basic operating exercises 

4. Connectivity 

a. By air 

b. WLAN 

c. Hotspot 



Learning 
Objective 

 

Subordinate 
Learning 
Objective 

Learning Content in the Order, which you should teach 
Everything must be learned through practical exercises! 

5. Start and operate important programs (use and practice programs as the 

students want) 

a. To phone 

b. Write mails 

c. Taking photos 

d. Film 

e. Chat (writing, speaking, pictures) 

f. Get information 

g. Radio and television programs 

h. Alarm clock and schedule 

i. Listen to music 

j. Orientation (maps) 

k. Telephone storage and online storage 

l. Home Banking 

m. Identification Kit 

n. More programs and apps possible 

Objective B: 
Essential 
Software Skills 
(How to use the 
software?) 
 

Basic Internet 

Skills (browser 

and how to 

operate) 

 

Concept of internet 

● How do computers communicate? 

● What is a server? 

● What is ISP (Internet Service Provider)? 

● What is www. (World Wide Web)? 

● What can you do on the World Wide Web     ? 

Connecting to the internet 

● Network 

○ Where do I find it? 

○ How do I connect to the Internet on my computer? 

■ hardware needed to connect to the Internet (modem, 

router) 

● How do I troubleshoot my connection? 

Applications and troubleshooting 

● What is a web browser? 

● How do I choose my web browser? 

○ InternetExplorer/Edge 

○ Chrome 

○ Firefox 

○ Safari (for MacOS) 

● What to do when I want to search the web? 

○ Where is the Address bar?  

■ URLs  

■ Links  

■ Navigation buttons (back, forward, refresh 

○ What are Tabs? 

■ tabbed browsing  

○ Where do I find my web search History? 

○ What are Bookmarks? 

■ How do I add Bookmarks? 

○ What is a Search bar? 

■ using search engines (Google, Yahoo, Bing) 

■ set a default search engine (in Chrome, Firefox, Edge)  

■ set the homepage (in Chrome, Firefox, Edge) 

■ refining your search (using a hyphen, using quotation 

marks) * 

○ Plug-ins* 



Learning 
Objective 

 

Subordinate 
Learning 
Objective 

Learning Content in the Order, which you should teach 
Everything must be learned through practical exercises! 

■ installing and updating plug-ins 

● Troubleshooting (browsers)* 

■ Why do I see Errors (400+, 500+)?  

Downloading and printing web pages 

● How do I download and save from the Internet? 

○ pages 

○ documents/files  

○ pictures  

● How do I print a web page? 

○ Do I need specific Settings? 

○ Can I use any printer? 

Word processing 

(basics of Word) 

Opening and closing documents 
● Open/create a new Word document 

○ from Microsoft Office 
○ from Desktop 

● Naming a Word document 
● Saving a Word document 
● Opening an existing document 

Text creation (writing) 
● Important parts of Word document 

○ Overview of File tab 
○ Overview of Quick Access Toolbar 
○ Overview of Ribbon 

■ Tabs 
■ Groups 
■ Commands 

○ Overview of Zoom Control  
○ Overview of Document Area  
○ Overview of View Buttons  
○ Overview of Status Bar 

● Writing in Word document (three basic rules of typing in Word) 
○ Rule 1: Within a paragraph, just keep typing 
○ Rule 2: Press Enter once at the end of every paragraph 
○ Rule 3: Use the spacebar after punctuation marks and use the 

spacebar before a capital letter at the beginning of a new 
sentence. 

● Moving within the Word document 
○ with Scroll Bars 
○ with Mouse 
○ with Keyboard 

● Selecting with Mouse 
○ single word 
○ sentence 
○ paragraph 

● Copy & Paste Operation 
○ with Mouse 
○ with Keyboard 

● Backspace function 
● Delete function 
● Copy, Cut & Paste in different documents 
● Undo & Repeat operations 

Formatting 
● Change the font type and size 
● Decorating text 

○ making text bold 
○ making text italic 
○ underline the text 
○ strikethrough the text 

● Change font colors 



Learning 
Objective 

 

Subordinate 
Learning 
Objective 

Learning Content in the Order, which you should teach 
Everything must be learned through practical exercises! 

● Highlight text with colors 
● Text Alignments 

○ Left-Aligned Text 
○ Center Aligned Text 
○ Right-Aligned Text 
○ Justified Text 

● Indent Paragraphs 
○ Left Indentation 
○ Right Indentation 
○ First Line Indentation 
○ Hanging Indentation 

● Create Bullets 
○ Bullet Button 
○ Numbering Button 

● Line Spacing 
○ Spacing between Lines 
○ Spacing between Paragraphs 

● Page Margins 
● Header and Footer 
● Page Numbers 
● Page Orientation 
● Adding pictures in Word document 

Creating and working with tables 
● Creating a table 
● Deleting a table 
● Overview of table design mode 
● Rows & Columns 

○ adding row/rows 
○ deleting row/rows 
○ adding columns/columns 
○ deleting column/columns 
○ merging cells 

● Borders and Shades 
○ adding borders 
○ using border options 
○ adding shades 

Spell checks, language settings and thesaurus 
● Common mistakes automatically detected by Word 

○ red underline (spelling errors) 
○ green underline (grammar errors) 
○ blue underline (correctly spelled but misused words) 

● Spell check using Spelling & Grammar button 
● Spell check using the mouse's right button      
● Using/changing language settings and thesaurus in Word document 

○ changing/choosing language on computer 
Printing Word documents 

● Overview of Print option 
○ how many copies 
○ print custom range 
○ page orientation 
○ page size 

Basic PowerPoint 
Skills 
 

Locate PowerPoint Icon on your desktop 
● Double click on PowerPoint icon           

o A new blank presentation and its title slide will appear on your 
screen or you can choose one of the themes and continue 

● Create a title page by typing your text inside the box 
● Add more slides by clicking “New Slide” in the toolbar above the slides 
● Add pictures, charts, graphs etc. by clicking on the “Insert” tab at the 

top of the window 
● Add transitions in between your slides by clicking “Animations” tab at 

the top of the page (here you can scroll all the options of transitions) 



Learning 
Objective 

 

Subordinate 
Learning 
Objective 

Learning Content in the Order, which you should teach 
Everything must be learned through practical exercises! 

Save your PowerPoint presentation by clicking the “File” tab and choose “Save as” 
and name it as you wish. 

Basic Excel Skills Locate Excel Icon on your desktop 
● Launch Excel icon      

o Initial page appears on your screen 
 

There are 5 important areas in the screen 
● Quick access toolbar: (When you start Excel for the very first time, it has 

only 3 icons (Save, Undo, Redo) 
● Ribbon: Ribbon is like an expanded menu. The most important ribbons 

are – Home, Insert, Formulas, Page Layout & Data. 
● Formula Bar: This is where any calculations or formulas you write will 

appear 
● Spreadsheet Grid: This is where all your numbers, data, charts & 

drawings will go 
Status Bar: This tells us what is going on with Excel at any time. The status bar 
also shows quick summaries of selected cells (count, sum, average, minimum or 
maximum values) 

Basic photo 
editor skills 

Photo Editor: Microsoft Picture Manager 
1. On your computer, locate the picture you want to work with 
2. Right-click the picture 
3. select Microsoft Office. Your picture will open in Picture Manager. 
4. Edit your pictures (By using the Edit and Picture menus and adjusting the 

following settings, you can change how your pictures look.) 
a. Brightness and contrast 
b. Color   
c. Crop 
d. Rotate and flip 
e. Red-eye removal 
f. Resize your picture 

5.    When you have finished editing, you can save the changes. Click Save to 
save your changes, or use Save As to create a new image, while keeping the 
original. 
6.    Share your pictures using e-mail messages, social media etc. 

Basic video editor 
skills 

Video Editor: Open Shot Video Editor* 
● Download from the website 

https://www.openshot.org/pt/download/     , once completed, 

OpenShot will be installed and available in your Start menu.  
● Double click to open App. And select videos, photos, and music to 

import in OpenSHot. (DRAG & DROP) 
● Arrange files (Photos, Videos) on timeline.  Drag each file onto the 

timeline. The timeline represents your final video, so arrange your 

photos in whatever sequence you want them to appear in your video.  

● Add Music to the Timeline     . Click on the music file and drag onto the 

timeline.   

● Preview your project by clicking the Play button under the preview 

window 

● Export your Video. Click on the Export Video icon at the top of the 

screen (or use the File > Export Video menu). Choose from one of the 

many preset export options and click the Export Video button. 

Objective C: 
Using ICT in 
Daily Life 
 

Online Safety 
Basics 

Short basic information in the form of tips and tricks 
● Communicating with friends and family  

● Meeting new friends and romantic partners  

● Avoiding scams  

● Online shopping, banking, charity, and travel 

● Dealing with Social Security and Tax Offices  

https://www.openshot.org/pt/download/


Learning 
Objective 

 

Subordinate 
Learning 
Objective 

Learning Content in the Order, which you should teach 
Everything must be learned through practical exercises! 

● How to Disable Location on your Mobile Device 

 

Basic E-mail Skills Use an E-Mail-Client as an example (e.g. Gmail) 
● How to set up an email account (Gmail - opening of email address, 

registration, login/logout) 

● How to communicate with others via email (writing email, work with 

attachments, work with received emails, use of integrated text editor, 

sending email to group of recipients, correct use of sending options - for, 

copy, blind copy, work with drafts) 

● How to manage your email account  

● Gmail application for mobile phones 

Social Media 
Basics & 
Communication 
Apps 

Social Media including Practical examples of use of different social media tools - 
browsing/searching, uploading, communication… 

o Common Social Media sites 

o How to set up a Social Media account 

o Getting started with Facebook 

o Getting started with Twitter  

o YouTube basics  

o Tips / Do’s & Don’ts  

Communication Apps, including Practical examples 
o Common Communication Apps 

o Getting started with Skype / Zoom 

o Getting started with Viber / WhatsApp  

o Getting started with Facebook Messenger 

o How to set up a camera and microphone  

o Tips / Do’s & Don’ts  

Media Literacy, Accessing News & Fake News 
o What is Media Literacy  

o How to search for news 

o What is fake news & the difference between facts and opinions  

o How to spot fake news and what to do about it   

Career Search & 
Online Education 

Career Search 
o Getting started with LinkedIn 

o How to create or update your Europass CV online  

 

Online Education 
o Use of Google classroom:  

- registration,  

- search for tasks and study material,  

- independent consolidation of knowledge,  

- solving exercises and uploading in online classroom,  

- searching for appropriate applications for individual learning,  

- creating e-folder with e-addresses of members, sending documents by 

e-mail to the group,  

- use of voice commands for online search, 



Learning 
Objective 

 

Subordinate 
Learning 
Objective 

Learning Content in the Order, which you should teach 
Everything must be learned through practical exercises! 

- uploading of dictionary on computer      or mobile phone,  

- use of application maps,  

- use of calendar,  

- uploading of cards on mobile phone,  

- registration to library (Biblos) and borrowing books,  

- use of Play store and uploading of free applications for learning,  

- use of Google drive 

o Learning web, web tools and applications:  

- solving interactive tasks, tests, riddles 

- independent creation of comics and uploading in online classroom or 

Google classroom 

o Learning interactive e-     books:  

- uploading e-     books on computer and using them,  

- video interactive content for independent learning,  

- translation of words 

Online Shopping o How to search for products and services  

o How to make online payments in e-shops  

Online Banking  o How to enroll and create an account in your bank of choice (online & mobile 

banking)  

o Methodical hint: each partner to include guides in own language material 

from banks that include the relevant information on how to use digital 

banking (online & mobile banking) like: available services, review of account 

state, payment of invoices, other transactions, ordering different services 

E-health & 
wellbeing, 
practical 
housework 

o Booking online medical appointments      e-medical referral 

Methodical hint: partners should include useful websites that provide this 

service and manuals if applicable 

o Use of applications for measuring heartbeat, number of daily steps, used 

calories, driven/run kilometers etc.  

o Applications for home repairs, gardening hints, “do it yourself” etc. 

Useful Apps and 
where to find 
them 
 

Identify different stores where you can get apps: 
● What is the name of the app provider of my smartphone/tablet? 
● Do I know Google Play Store or App Store? 
● How to download an app from the store? 
● What type of apps do I prefer? 
● Do I know how to pay for an app? 

Working with 
smartphone 
cameras 

Taking pictures  
● Basics of camera hardware and software 
● Smartphone camera’s instructions 
● Concepts such as pixel size, focal length, etc. 
● Academic/practical use of pictures 
● Zooming 

Recording videos 
● Basics of video recording 
● Academic/practical use of video recording 

Editing pictures 
● Basics of photo editing (crop, filters, etc.) 
● Instant notes from lessons for later reference 
● Using the smartphone camera as a scanner 
● Using the smartphone camera for making creative presentations 
● using digital photos to make story books 
● photo collages 

Editing videos 
● Basics of photo editing 



Learning 
Objective 

 

Subordinate 
Learning 
Objective 

Learning Content in the Order, which you should teach 
Everything must be learned through practical exercises! 

● Creating visual guides or tutorials 
● Creating video podcast for practical purposes 
● Creating motion design videos with subtitles and transcripts  

Where can I find tutorials on how to edit and work with images? 
● Youtube 
● Lynda.com 
● Adobe.com 

Video 
platforms/sites 

Using video sharing platforms in a responsible way 
1. Knowing video sharing platforms/video sites (Youtube, Vimeo, etc.) 
2. Watching videos 

a) Knowing educational video sites (EDx, iTunesU, Khan Academy, TED, 
SchoolTube...) 

b) Watching videos for academic purposes 
c) Watching videos for entertainment 
d) Watching self-help videos for personal development through video 

channels such as TEDx talks... 
3. Downloading videos 

a) Protection of privacy when downloading videos 
b) Keeping privacy settings up to date on video sharing platforms 
c) Different procedures to choose formats to download videos      
d) Downloader tools (catch.tube, catchvideo.net...) 
e) Intellectual property 

4. Uploading videos 
a) Protection of privacy when uploadingdownloading videos 
b) Knowing the rules of video sharing sites 
c) Different procedures on how to upload videos  

Promoting work through videos online 

Cloud service 1) What is a cloud service? 
2) Why is it intricately connected to the Internet? 
3) Types of cloud services 

a) Public cloud 
b) Private cloud 
c) Hybrid Cloud 
d) Community cloud 

4) Advantages of using the cloud 
a) Improvement of collaborative work 
b) Backup for your most important       documents 
c) Send large files to family, friends, and coworkers 
d) Easy sharing of videos and photos 

5) Cooperative working - Google Drive  
a) Creation of teams to collaborate in real time  
b) How to upload documents 
c) How to share folders 
d) How to add a collaborator on Google Drive 

6) How to edit a shared document 

Using  
e-governance 
website 

1. Getting familiar with governmental services through the Internet.  
2. What are the most useful services for citizens? 
3. Efficient online tools used for e-participation 

Designing simple 
website 

1. Different purposes of websites 
2. Platforms for the creation of simple websites 

● Google Sites 

● Blogspot 

● WordPress 

● SiteW 

● ... 

3. Organizing contents of websites  
4. Information architecture and information design 



Learning 
Objective 

 

Subordinate 
Learning 
Objective 

Learning Content in the Order, which you should teach 
Everything must be learned through practical exercises! 

Objective D: 
The concept of 
privacy and 
why privacy 
matters online 
 

Essential security 
skills 
 

Use of password  
● Why do we need a password? 
● Understand the functions of password 
● How can a secure password help me protect my private information? 
● Are some passwords better than others? 
● What happens when I forget my password? 
● Is there anyone I can or should share my password with? (my friend, my 

parents) 
● True or false: The best password is my phone number or my birthday? 
● Identify the characteristics of strong password 

Create secure password 

What happens to 
personal 
information once 
it is posted online 

Manage my own digital footprint 
● What is a digital footprint? 
● Components of a digital footprint 
● Difference between an active and positive digital footprint 
● Is it a negative or a positive thing to have? Why? 
● Does everyone have a digital footprint? 

Special attention on my privacy in Internet 
● How do I express myself? 
● How do I protect my privacy? 
● Do I respect other people’s privacy? 

Use of personal data 
● What is private information? 
● Who needs privacy? Why? 
● Who should be allowed to have access to/collect/retain my private 

information?  
● Questions to be discussed:  

o Under what circumstances, if any, should someone be allowed 
to have access to my private information without my consent?  

o If we share our own private information with another person, 
government actor, or private company, what should they be 
allowed to do with it? 

Antivirus and 
anti-malware 
protection 

Relevance in dealing with today's digital threats 
● What is the difference between antivirus and anti-malware? 

● What is cybersecurity? 

● What is a computer virus? 

● Status of computer viruses and antivirus programs 

● Why do I need cybersecurity? 

Security software for computers, smartphones, and tablets  
● Why do computers, smartphones and tablets need protection? 

● How do computers, smartphones and tablets get infected? 

● Security threats I can protect myself from, the risk of: 

o Third-party application stores 

o Drive - by downloads 

o Viruses and Trojans 

Tips to help to protect my computer, smartphone, and tablets 
● Install and use security software 

● Always install software updates 

● Be aware of the apps I install 

● Lock my device 

● Download apps from official app stores 

● Always read the end-user agreement 



Learning 
Objective 

 

Subordinate 
Learning 
Objective 

Learning Content in the Order, which you should teach 
Everything must be learned through practical exercises! 

Essential skills for 
email protection 

Protecting myself 
● Make my password difficult to guess 

● What is Spam? 

● Spam-junk mail that could harm my computer 

● How to move spam to spam folder 

● Phishing - It is a scam that pretends to be an official communication 

from a trusted source, like a bank, trying to get valuable information 

from the user. 

● Opening fraudulent attachments 

 Financial digital 
literacy 

Avoiding Fraud and Scams 
● What are fraud and scams? 

● How to identify fraud and scams? 

✔ Detection methods 

✔ Indicators and warnings 

✔ Tools and technics 

● Different types of financial scams 

● Key signs to identifying financial scams and how 

to protect myself 

● Key signs to financial fraud and reporting procedures. 

 Fake news Avoiding fake news 
● What is fake news? 

● How to avoid fake news 

● The danger that fake news poses to me, to education and to democracy           

 

 


